Contents

1. Absolute and relative cell referencing
   Relative referencing .......................................................... 2
   Absolute referencing ........................................................ 2
   Mixed referencing ............................................................ 3
   Task 1.1 Relative formulas .................................................. 3
   Task 1.2 When relative formulas are inappropriate ...................... 3
   Task 1.3 Absolute references .............................................. 4

2. Subtotalling
   Task 2.1 Creating subtotals .................................................. 4
   Task 2.2 Nested subtotals ................................................... 6

3. Renaming, managing and linking worksheets
   Renaming worksheets ........................................................ 7
   Task 3.1 Renaming worksheets .............................................. 7
   Managing multiple worksheets ............................................ 7
   Linking to other worksheets .............................................. 7
   Task 3.2 Referring to cells in other worksheets ......................... 7
   Referring to cells in other worksheets ................................ 8
   Task 3.3 Referring to cells in other workbooks ........................ 8
   Grouping Worksheets ....................................................... 9
   Task 3.4 Grouping Worksheets ............................................ 9

4. Naming a Range
   Task 4.1 Defining Names .................................................... 10
   Using Names in Formulas .................................................. 10
   Task 4.2 Using Names in Formulas ....................................... 10

5. Functions
   The Sum Function ........................................................... 11
   The Average Function ...................................................... 11
   The Round Function ........................................................ 11
   Task 5.1 Sum, Average and Round Functions .......................... 11
   Logical Functions ........................................................... 12
   IF .............................................................................. 12
   Task 5.2 Using IF to return information ................................ 12
   Nested Functions ............................................................ 13
   Nested IF ...................................................................... 13
   Task 5.3 Nesting IF Functions .............................................. 13
   Task 5.4 Working out the grade using the round function ............ 13
   Task 5.5 Calculating values with the IF Function ..................... 14
   Lookup Functions ............................................................ 14
   The vlookup function ....................................................... 15
   Task 5.6 Using vlookup ..................................................... 15
   Task 5.7 vlookup for Exact Matches ...................................... 16

If you require this document in an alternative format, such as large print, please email IS.skills@ed.ac.uk.

Copyright © IS 2019
Permission is granted to any individual or institution to use, copy or redistribute this document whole or in part, so long as it is not sold for profit and provided that the above copyright notice and this permission notice appear in all copies.

Where any part of this document is included in another document, due acknowledgement is required.
6. Filters
Preparing to filter ........................................................................................................ 16
Filtering Text ............................................................................................................... 17
  Task 6.1 Filtering Text .............................................................................................. 17
Filtering options and custom filters ........................................................................... 17
  Task 6.2 Filtering Text .............................................................................................. 18
Filtering Numbers ........................................................................................................ 18
  Task 6.3 Filtering Numbers ...................................................................................... 18
  Task 6.4 Removing a filter ....................................................................................... 18
Filtering Dates ............................................................................................................. 18
  Task 6.5 Filtering Dates ........................................................................................... 19

7. Pivot Tables
  Task 7.1 Create a Pivot Table.................................................................................... 20
  Task 7.2 Display data for specific items .................................................................. 20
Formatting the data ....................................................................................................... 21
  Task 7.3 Calculate the average mark for each subject ............................................ 21
Grouping data ............................................................................................................... 21
  Task 7.4 Grouping data in PivotTables ................................................................... 21
PivotTable Slicers .......................................................................................................... 22
  Task 7.5 Creating Slicers ....................................................................................... 22

Course Conclusion
  Downloading the course files: .................................................................................. 22
  Lynda.com playlist: .................................................................................................. 22
Microsoft Excel Intermediate

This course builds on your existing Excel knowledge. It is at intermediate level and is intended for those with previous experience in using Excel. Intermediate means different things to different people, and from time to time people find parts of the course easier or more difficult than they expected. The main purpose of the course is to enhance your Excel knowledge, and to ensure you to leave the course with greater knowledge than you had when you arrived.

Many people don’t finish the book on the day as it contains many exercises, and not all of the exercises are relevant for everyone. You can carry on with the exercises in your own time, the location of the workfiles can be found towards the end of this workbook.

With increased Excel knowledge you will be able to carry out aspects of your work more efficiently. You may also find use for Excel at home e.g. for working out your budget or storing information on CDs, household items etc.

The main topics covered today are:

- Formula Referencing
- Summarising and Subtotalling
- Managing Worksheets
- Logical and Lookup functions
- Filters and Pivot Tables.

These topics have been chosen because they are the most frequently requested Excel topics in the University. If there are other areas you think it would be worth creating exercises in please let the tutor know.

Recap on the uses of Excel

Excel is an electronic spreadsheet application that can be used for storing, organizing and manipulating information. Excel is very flexible as it allows you to choose how you wish to structure the information you enter.

You will most likely be aware of many of the uses of Excel, these include:

- budget forecasting e.g. income and expenditure, annual business reports
- invoicing
- storing information e.g. student records, patient records, research data
- demonstration tool e.g. to show how you arrived at the result of your calculation
- scientific and statistical analysis
- tracking and decision making tool

We hope you enjoy this course and find it useful. If you have any questions on the course the tutors will be happy to answer them.
1. Absolute and relative cell referencing

Excel is frequently used to carry out calculations using formulas. These formulas are created using **cell references** e.g. B3 or D5 rather than actual values, e.g. 2.8 or 5.3. Using cell references allows a change of variable in one cell to be reflected in any dependent cells.

Relative referencing

By default, cell references in a formula are relative which means that when the formula is copied elsewhere the **references will adjust**, relative to their new position.

The use of **cell references** rather than actual values for formulas provides **flexibility** and enables:

1. Copying of formulas to other cells to quickly repeat a calculation.
   - This **saves time** when working with **complex formulas**, and if the calculation needs to be repeated several times.
2. The calculation results will be automatically updated when the source cell values change.

For example the formula in cell C1 is =A1+B1

When you copy the formula to another area of the spreadsheet the cell references will change to reflect the new location. This is called relative referencing because the cell address changes relative to the location. You can then duplicate the formula in other cells.

If the value in either A1 or B1 changes then this is immediately reflected in cell C1 because cell references rather than values are used.

Relative references adjust to location.

In another example where a range of cells is added up

=SUM(B3:B7) copied becomes =SUM(C3:C7)

Absolute referencing

At times you may need the cell reference in a formula to remain fixed in a specific location. For example you may wish to store a currency exchange rate in one cell.

When a cell reference in a formula is **absolute**, the **reference does not change** when the formula is copied.

When you multiply a particular value by the exchange rate you want the **exchange rate to remain constant** and ensure your formula always refers to the same cell.

To fix cell references and make them absolute place a $ sign in front of the row and column co-ordinates e.g. to multiply the value in B4 by the exchange rate in G4, first change G4 to $G$4, then copy the formula down the column

= B4*$G$4

Absolute references remain constant regardless of location. The $ sign is used e.g. $G$4 to make cells absolute.
Mixed referencing

A mixed reference is one where either the column letter or the row number is fixed, for example:

$A1$ (if the formula is copied, the column letter will not change) or

$A$1 (if the formula is copied, the row number will not change)

Task 1.1 Relative formulas

Most formulas in Excel will be relative resulting in cell references changing when the formulas are copied to other locations.

1. Open the file Absolute1
2. Click in cell B9
3. Click the down arrow next to AutoSum in the Editing group on the Home tab, select Sum and press Enter
4. Click on B9 again, and drag the small square handle (the fill handle) at the bottom right corner of the cell along to E9. (This copies the formula from B9 to E9)
5. Click in the cell F6
6. Select the Sum command and click Enter
7. Click on F6 again and drag the fill handle to F9. (This will copy the formula from F6 to F9). Save and close the workbook.

This is copying relative cell references. We will now look at using absolute referencing.

Task 1.2 When relative formulas are inappropriate

Sometimes a value in a formula needs to be located in a specific cell, row or column i.e. the formula must include an absolute cell reference. This exercise illustrates what happens when the formula doesn’t work as required.

1. Open the file Absolute2
2. Click in C11 (we want to calculate the product’s surcharge)
3. Type =B11*B5 and press Enter
4. Click in C11 again (we now want to fill the other cells)
5. Move the mouse pointer to the fill handle at the lower right corner of the cell and drag down to cell C22

The results are not what we require.

As we filled the cells in column C the value we multiplied by changed from 12% (the value in B5) to zero (the value in B6 which is empty) and so on down column B.

We’ll correct this in the next exercise when we make the cell reference to B5 absolute.
Task 1.3 Absolute references

In this exercise we need the value we are multiplying by to remain fixed when the formula is copied down a column. i.e. we need to make the cell reference absolute.

1. Using the file Absolute2 click in cell C11. Move to the formula bar at the top of the screen, and then click within the B5 cell reference in the formula in the formula bar.

2. Press F4 (the key to change references to absolute) several times. Observe that the cell reference changes from $B$5 to B$5 to $B$5 and then B5 each time you press F4

3. Press F4 until B5 appears as $B$5 and press enter

4. Click in C11 and press enter. Now click in C11 again and move the mouse pointer to the fill handle at the bottom right of C11, and drag the handle down to C22 to fill the formulas down the column. Save and close the workbook.

Note: When copying a formula, you can make it relative or absolute.
- Relative references adjust to location
- $=SUM(B3:B7)$ copied becomes $=SUM(C3:C7)$

Absolute references remain fixed regardless of location. Use the $ sign e.g. $A$1

2. Subtotalling

We often need to calculate the grand total of values stored in a list. In addition, we may need to subdivide the data and calculate subtotals. Fortunately, Excel provides a subtotal function which can be used to carry out any subtotal calculations.

When using the subtotalling function the data needs to be ‘tidy’ e.g:
- Column headings must be unique
- There should be no blank rows or columns as Excel stops sorting when it meets a blank row or column
- The data must be sorted in the column to be subtotalled

When using subtotalling Excel applies outlining to group data. You can use this outlining feature to show and hide details using the expand and collapse buttons.

Task 2.1 Creating subtotals

When subtotalling Excel adds a new row containing the subtotal at each change in the data. It also applies outlining to the list.

1. Open the file ProductSummarising

We are going to create subtotals so first we will sort the data

2. Click on any cell in the Store column

3. On the Home tab of the ribbon, click on Sort & Filter in the Editing group and select Sort A to Z

We now want to add subtotals for each store
4. Click on the **Data** tab, then click on **Subtotal** in the **Outline** group, to display the Subtotal dialog box.

5. Click on the drop arrow for **At each change in** and click on **Store**.

6. Ensure the other settings are as shown in the screenshot and click **OK**.

An outline will appear in the worksheet and the product costs will be subtotalled at each change in store.

7. Scroll to the bottom of the data to see that Excel has also calculated the grand total of the costs.

### Subtotalling syntax

When you click on a subtotal within the data the formula bar shows the formula generated by subtotal function. In the case of a subtotal **sum** the formula is

\[ \text{sum} = \text{SUBTOTAL}(9, F2:F8) \]

The format of the formula is **SUBTOTAL**(function_num, ref1, ref2, ...)

The **function_num** specifies the type of function to use in calculating subtotals within a list. The function number for the subtotal **sum** is 9. Popular function numbers include average, count and max as listed in the following table:

<table>
<thead>
<tr>
<th>Function Number</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AVERAGE</td>
<td>The <strong>AVERAGE</strong> function returns the average of the numbers given as arguments</td>
</tr>
<tr>
<td>2</td>
<td>COUNT</td>
<td>The <strong>COUNT</strong> function counts cells containing numbers</td>
</tr>
<tr>
<td>3</td>
<td>COUNTA</td>
<td>The <strong>COUNTA</strong> function counts non empty cells</td>
</tr>
<tr>
<td>4</td>
<td>MAX</td>
<td>The <strong>MAX</strong> function returns the maximum value</td>
</tr>
<tr>
<td>5</td>
<td>MIN</td>
<td>The <strong>MIN</strong> function returns the minimum value</td>
</tr>
<tr>
<td>6</td>
<td>PRODUCT</td>
<td>The <strong>PRODUCT</strong> function multiplies all the numbers given as arguments and returns the product. e.g. if cells A1 and A2 contain numbers, you can use the formula =PRODUCT(A1, A2)</td>
</tr>
<tr>
<td>7</td>
<td>STDEV</td>
<td>The <strong>STDEV</strong> function is a measure of how widely values are dispersed from the average value</td>
</tr>
<tr>
<td>9</td>
<td>SUM</td>
<td>The <strong>SUM</strong> function returns the sum of the numbers given as arguments</td>
</tr>
</tbody>
</table>

The **SUBTOTAL** function can be used directly. The first parameter in the sum subtotal function is 9, i.e. using 9 in the formula tells Excel to sum the figures, using 2 tells Excel to count the figures. e.g.

- **Subtotal Average** = **SUBTOTAL**(1, F2:F8)
- **Subtotal of Count** = **SUBTOTAL**(2, F2:F8)
Task 2.2 Nested subtotals

You can create another level of subtotalling in addition to subtotals of the cost. Creating another level produces nested subtotals. To create nested subtotals you first sort the data again on the main grouping, and then on the secondary grouping.

1. Continue working with the file ProductSummarising and ensure your cursor is placed within the data table.

2. Choose Sort & Filter on the Home tab. Select Custom Sort

3. Click the Add Level button

4. Click the drop down arrow for Then by, choose Product, and click OK

5. Click OK to the message “This removes the subtotals and sorts again”.

6. Now click the Data tab, and choose Subtotal to display the Subtotal dialogue box

7. Click the drop down arrow for At each change in, choose Store and click OK (the settings should be retained from the previous exercise)

We will now add a second subtotal

8. Click on the Subtotal button again. This time At each change in select Product

9. This time remove the tick next to Replace current subtotals (if it is ticked) and click OK

Notice that both the Store and Product subgroups are subtotalled.

10. Save and close the workbook.

Tip: The subtotal function is used to sum or average sections of data. It can be used for creating a subtotal: Sum, average, maximum or minimum. Examples of use: student exam marks, sales figures, expenditure records

Note: With Subtotalling and Filtering the data needs to be ‘tidy’ i.e.

- Column headings must be unique
- Data must be sorted
- No blank rows or columns
3. Renaming, managing and linking worksheets

Renaming worksheets

By default, Excel names new worksheets consecutively: Sheet1, Sheet2 etc. In order to keep track of, and add meaning to information in your workbooks you can rename them.

Task 3.1 Renaming worksheets

To give your sheet a different name to the default, double click the sheet tab, or right click the sheet tab and choose rename.

1. Open the file Linking
2. Activate the Sheet2 tab and rename it (by double clicking or right clicking and choosing rename) as Year2012
3. Repeat this procedure to rename Sheet3 as Year2013 and Sheet4 as Year2014

Managing multiple worksheets

In Excel you can insert, move and copy worksheets from one workbook to another. You can also refer to cells and ranges in other worksheets, or other workbooks.

Inserting worksheets

To insert a worksheet right-click the tab of the worksheet before which you want to insert the new worksheet, choose insert and select worksheet from the General tab.

Moving and copying worksheets

You can move a worksheet by dragging it to a new location. To copy a worksheet hold down the Ctrl key when dragging the worksheet to a new location.

Linking to other worksheets

To link worksheets use references to cells in other worksheets to get data into your main worksheet. e.g. you might keep a summary worksheet and link to this from other worksheets.

To link cells between worksheets precede the source cell reference in the formula with the sheet name, followed by an exclamation mark:

worksheetname!reference e.g. Year1!C4

Task 3.2 Referring to cells in other worksheets

1. Continue working with the file Linking. This worksheet contains data for three consecutive years’ temporary staff hours. It also contains a summary sheet.
2. Ensure the worksheet Summary Data is activated
3. Click on cell B6 and type =
4. Click on the worksheet tab for Year2012, click in cell F6, and press Enter

Pressing enter should return you to the sheet Summary Data. We’ll now try another way of linking sheets…

5. On the sheet Summary Data click on cell B8 and type =Year2012!F4 and press Enter
6. Click on B15 and use the technique in steps 4 or 5 to build the formula:
   =Year2012!F8+Year2013!F8+Year2014!F8 and press Enter.
Referring to cells in other workbooks

When you create a link to another workbook, Excel creates a formula that includes the name of the source workbook in brackets [ ], followed by the worksheet name. The combination of workbook name followed by worksheet name needs to be surrounded by single quotation marks. Excel follows this with an exclamation mark and the cell reference.

'[workbookname]worksheetname'!reference  e.g. '[Company Sales]Year1'!C4

References to other workbooks are called external references. When linking a workbook in a particular folder to a workbook in a different folder, the formula must include the full path to the workbook. e.g.

Please note: Linking to other workbooks depends on how your machine is set up. It may not work on training machines.

**Task 3.3 Referring to cells in other workbooks**

1. Ensure the file **Linking** is still open.
2. Choose **File, New** and choose **Blank Workbook**
3. Enter the text as in the screenshot
4. Ensure **Linking** is still open
5. Click on **B4**
6. Type = [Linking.xlsx]Year2012!B8*30%
7. Click on cell **B4** and drag the fill handle in the bottom right hand corner of the cell to copy the formula across to **E4**
8. Save and close the workbook as **Overheads Report.xlsx** within the folder **Excel Intermediate 2013** and close the file.
9. Close the file **Linking**, save the changes if asked.

**Note:** If you make a change in the original workbook and then open the second workbook containing links to the original you may get the message *This workbook contains links to one or more external sources that could be unsafe*. Files stored in the training rooms have been virus scanned so you can choose the option to update the links and get the latest data.
Grouping Worksheets

Grouping worksheets enables you to make the same change to all of the selected worksheets in one go. This is useful when you need to enter the same information into several worksheets at once.

Task 3.4 Grouping Worksheets

1. Open the file Grouping Worksheets
2. Click on the 2014 worksheet tab, hold down the shift key and click on the 2016 tab so that the worksheets named 2014, 2015 and 2016 are all selected.
3. Notice that [Group] appears at the top of the screen after the filename, this indicates that grouping has been activated.
4. Click in cell B1 and type Income and Expenditure, format the text to make it bold, 18pt and blue.
5. Click in cell A3 and type Income
6. Click in cell A4 and type Expenditure
7. Click in cell B2 and type January, format the rest of the text you have typed in and make it bold.
8. Click in cell B2 again and hover over the bottom right hand corner of the cell until a + sign appears, click and drag the + sign along to cell M2 so that the cells are automatically filled with January – December
9. Click on the 2015 worksheet tab and notice that all the information you have typed in sheet 2014 has also been entered into the 2015 worksheet
10. Save the changes and close the file.

Note: While worksheets are grouped any changes made to one worksheet will appear on every worksheet in the group. However, if you select a worksheet that is not in the group, all of your worksheets will become ungrouped.
4. Naming a Range

Naming cell ranges makes the
- ranges more meaningful and
- formulas easier to understand.

Names can also be used to locate specific places in a spreadsheet. It is best to name cells ranges before using formulas:

Defining a name can be done under the Formula tab, Define Name, New Name

You can also define a name by selecting a range of cells and typing a name in the name box which is to the left of the formula bar.

Task 4.1 Defining Names

We will define names to represent ranges in the workbook Sales.

1. Open the file Sales
2. Ensure the worksheet North is selected
3. Select B5:B9
4. Edit the name box to read NorthWin and press Enter.
5. Name C5:C9 as NorthSpr, press Enter
   Name D5:D9 as NorthSum, press Enter
   Name E5:E9 as NorthAut, press Enter
6. Go to the Formulas tab and choose Name Manager to see the list of names.

If you need to change the name or the cell range click the Edit button within the Name Manager dialogue box.

Note: You can only use letters or numbers in names. Spaces and other characters are not permitted. Names must also begin with a letter.

Using Names in Formulas

Once range names have been defined they can be used in formulas. Range names are stored in Excel's internal listing within the workbook.

Task 4.2 Using Names in Formulas

1. Ensure the file Sales is open.
2. Click on cell B10, type =sum(NorthWin) and press Enter
3. Calculate the total cakes sales for each season in the North. Use the sum formula and the names NorthSpr, NorthSum and NorthAut as appropriate.
4. Save and close the file.
5. Functions

Functions are predefined formula. The functions in Excel fall into various categories including mathematical, logical and lookup. Different categories are often used together.

Basic components of functions are:

- they always begin with an = sign
- they consist of the name of the function, the arguments, and text and numbers

The arguments are the data and cell references that the function is carried out on, and are contained within brackets. Arguments can also be other functions (nested functions).

Arguments that include cell references can be a range of cells or cells separated by commas.

If there is more than one argument a comma must be used to separate them e.g. =SUM(C5:D5,B20)

All Excel functions can be found via buttons on the formula tab.

The Sum Function

The SUM function adds up ranges of cells. e.g.

=SUM(A3,B5,D1,E2) or =SUM(B3:D5)

The Average Function

The AVERAGE function works out the arithmetic mean (the sum of a list of numbers divided by the size of the list).

=AVERAGE(A2,C4,D2) or =AVERAGE(C7:E7)

The Round Function

The ROUND function is used to round a number to a specific number of decimal places. The ROUND function has two arguments.

=ROUND(D5,0) will round up the number in D5 to 0 decimal places and
=ROUND(B3,1) will round up the number in B3 to 1 decimal place

Note: The syntax for the ROUND functions is: ROUND(number,numdigits)

The first argument of the function is the number you want to round, the second argument is the number of digits to which you want to round the number.

Task 5.1 Sum, Average and Round Functions

1. Open the file Marks and have a look at the file.

The file contains a fictional list of student exam and practical marks. We are going to use functions in Excel to work out:

- the average mark for each student
- whether they have passed or failed
- the grade they obtained

2. In cell F7 type =SUM(C7:E7) to calculate the total marks the student obtained.
3. Copy the formula down the column to see the total marks for all the students.

4. Go to cell G7 and type \(=\text{AVERAGE(C7:E7)}\) to calculate the average mark for the student. Copy the formula down the column.

5. Go to cell H7 and type in \(=\text{ROUND(G7,0)}\) to round off the average mark to the nearest whole number. Copy the formula down the column.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Metric No</th>
<th>Exam 1</th>
<th>Exam 2</th>
<th>Practical</th>
<th>Total</th>
<th>Average</th>
<th>Rounded</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>J Draper</td>
<td>0013245</td>
<td>60</td>
<td>79</td>
<td>70</td>
<td>209</td>
<td>69.666667</td>
<td>70</td>
</tr>
<tr>
<td>8</td>
<td>H Brown</td>
<td>0032432</td>
<td>45</td>
<td>50</td>
<td>50</td>
<td>145</td>
<td>48.333333</td>
<td>48</td>
</tr>
<tr>
<td>9</td>
<td>B Olson</td>
<td>0023432</td>
<td>95</td>
<td>89</td>
<td>67</td>
<td>251</td>
<td>83.666667</td>
<td>84</td>
</tr>
</tbody>
</table>

Tip: The Round function can be a very useful function. Using the Round function on a value, rather than using formatting to round, can make a significant difference to subsequent calculations on the rounded value.

Logical Functions

Logical functions test whether a condition is true or false and can be used in decision making. The result of the decision can be used to display information or perform further calculations. Examples of logical functions include IF and IFERROR.

IF

The IF function is the fundamental logical function for decision making. It is set out as follows:

\[=\text{IF(condition, true, false)}\]

If a condition is true then return true, and if false, return false.

True and false can be substituted by

- words of your choice surrounded by quotation marks or
- further calculations or further functions (referred to as nested functions)

e. g. \(=\text{IF(C2>=150,"Signature required","Standard")}\)

In the example above \(C2>=150\) is the condition being tested. i.e. if the value in \(C2\) is greater than or equal to 150 then display the text "Signature required" in \(D2\) otherwise display the text "Standard"

Task 5.2 Using IF to return information

The IF function can be used to display the result of a condition test. In the following example the IF function is used to display the result 'pass' or 'fail' for students taking a particular course.

1. Continue using the file Marks and go to cell I7
2. Type \(=\text{IF(H7>=50,"Pass","Fail")}\) and press enter
3. Copy the formula down the column

Tip: If you want the cell to remain blank if the result is false enter two double quotes " " instead of text e.g. \(=\text{IF(H7>=50,"Pass","")}\)
Nested Functions

A nested function is a function which is encapsulated within another function. When this happens the nested function becomes an argument of another function.

Nested If

Nested functions are often used in conjunction with the IF function. i.e. you can use another IF function in place of False. If the result of the first condition is false, then the second condition will be tested.

\[ f(x) = \text{IF}(H7>=70,"A",(\text{IF}(H7>=60,"B",(\text{IF}(H7>=50,"C","Fail"))))) \]

In the above example we potentially need to make more than one decision before arriving at an answer.

First we ask if \( G7\geq70 \), and if it is, then Excel will enter "A" in the cell. However, if \( G7 \) is less than 70 then we ask another question e.g. is \( G7\geq60 \), and so on until we enter a value if all conditions are false.

Task 5.3 Nesting IF Functions

1. Continue using the file Marks and click in cell J7.
2. Type \( =\text{IF}(G7>=70,"A","\) ,

We now want to make our expression more readable by splitting it over several lines. Pressing the Alt and Enter keys creates a new line.

3. After the comma press Alt and Enter to create a new line.
4. Type \( \text{IF}(G7>=60,"B", \) , and press Alt and Enter
5. Type \( \text{IF}(G7>=50,"C", \) , and press Alt and Enter
6. Type "Fail")) ) and press Enter
7. Notice the result in cell J7 and copy the formula down the column.

The result in J7 is a B and the candidate obtained 69.6667 as an average mark. If the result had been rounded up they would have gained an A. We will see how to remedy the grade in the next exercise.

8. To see the whole formula in the formula bar hover over the bottom of the formula bar until a double arrow appears, then pull the formula bar down to increase its size.

Task 5.4 Working out the grade using the round function

The different categories of function are often used together, and this exercise illustrates the usefulness of the round function. We will work out the grade using the values from column H in which the average result has been rounded to the nearest whole number.

1. Continue using the file Marks and click in cell K7
2. Type \( =\text{IF}(H7>=70,"A","\) ,
3. Type \( \text{IF}(H7>=60,"B", \) , and press Alt and Enter
4. Type \( \text{IF}(H7>=50,"C", \) , and press Alt and Enter
5. Type "Fail")) ) and press Enter
6. Notice the result in cell K7 and copy the formula down the column.
The result in K7 is an A. This time we have worked out the grade based on the value in H7 which has been rounded to 70. Close the file without saving the changes.

**Note:** The ROUND function can produce some intriguing results. When using ROUND(number,numdigits)
- if the numdigits equals 0 the function rounds to the nearest whole number. ROUND(56.78,0) returns 57
- If numdigits is negative, the function rounds to the left of the decimal point. ROUND(57.78,-1) returns 60

**Task 5.5 Calculating values with the IF Function**

In addition to returning text results, the IF function can be used to carry out further calculations based on the result of the condition.

e.g. If the condition is true, the function can carry out a particular calculation and, if the condition is false, the function can carry out an alternative calculation.

1. Open the file called *Formulas* and ensure the IF worksheet is active
2. Select G7. We are going to use the IF function to calculate the commission for each salesperson.
3. Type =IF(F7>10000,F7*2%,"Not applicable") and press Enter
   
   F7>10000 is the condition that the IF function will evaluate. If the condition is true then the salesperson will be awarded commission to the value of 2% of their total sales. If the condition is false the words Not applicable will appear in the cell.

4. Copy the formula in G7 down the column to G21
5. Observe the results, then save and close the workbook.

**Lookup Functions**

Lookup functions allow you to search a list or table range and return a value from a cell in that range. They are handy when you have a large spread sheet or need to look up something repetitively.

They can be used to return:
- A text comment or grade based on an exam mark
- Data in a specific location
- A product description and price based on its code or name
- Employee information based on employee id

Lookup functions require:
- a data table to look in, this is a cell range which can be named
- a calculation area where the function is entered and the retrieved values appear
The vlookup function

Vlookup is the vertical lookup function and returns a value on the same row of the range of data you are looking in. It has 4 arguments:

\[
\text{VLOOKUP(lookupValue,lookupTable,colNum,matchType)}
\]

- \text{lookupValue} is the first argument. This value must be located in the first column of the lookup table
- \text{lookupTable} is the second argument
- \text{colNum}, the third argument is the column number from which you wish to return a value
- \text{matchType}, the forth argument is optional if you do not require an exact match. If you specify \text{true} or omit the argument the function searches for an approximate match. If you specify \text{false} the function searches for an exact match to the lookupValue.

Task 5.6 Using vLookup

The most common lookup function is VLOOKUP, the vertical lookup. This function searches vertically down a \textit{sorted} data table looking for a match.

1. Open the file \textit{StudentLookup} and click in cell C2
2. Type the text \textit{See tutor}, \textit{Try harder}, \textit{Satisfactory}, \textit{Good}, \textit{Very good} and \textit{Excellent} into the cell range C2 to C7 (See screen shot).
   This completes the data table that we are going to look up values in.

Observe that the data table is already sorted which is essential before using vlookup.

We shall now name the data table to make the cell ranges easier to refer to.

3. Highlight cells A1 to C7
4. Edit the Name Box (to the left of the formula bar) to read \textit{Comment}
5. Click in cell D11
6. Type \textit{=vlookup(C11,Comment,3)} and press Enter

\text{VLOOKUP} searches vertically in the range of cells in the table. It searches for a value nearest to the value in C11 in the table \textit{Comment} and returns the description in the column you specify (in this case column 3)

7. Copy the formula down the column.

The formula has returned a comment for each mark because we looked for an approximate match to each of the marks in the table.

When looking for an approximate match we don’t have to include the 4\textsuperscript{th} argument. If the value lies between two values in the table then \textit{vlookup} returns the comment next to the closest least value.
Task 5.7 vLookup for Exact Matches

On occasions, you may only want to return a value if an exact match to the value you are looking up is found. This can be achieved by adding a fourth argument match type at the end of the vlookup formula. For exact matches the match type must be set to false.

e.g. =VLOOKUP(C11,Comment,3,false)

1. Continue working with the file StudentLookup
2. Click in cell E11
3. Type =vlookup(C11,Comment,3,false) and press enter

Excel will return the result #N/A because there is no exact match for the value 68 in the Comment table.

4. Copy the formula down the column and observe the results.

Notice that Excel has only returned a comment for values that have an exact match in the Comment table. Save the workbook.

Note: It is crucial to sort the table when using lookup functions. Excel doesn’t just work its way down a column, it uses a binary search technique searching out from the middle of the list, so if you don’t sort the table first it is likely to produce inaccurate results.

6. Filters

When you are working on a worksheet with many rows of data, it can be difficult to view and analyse the data. This is where you can use filters to control what you see.

Filtering is a quick way to find and work with a subset of data in an Excel range. Filters enable you to find all the entries for a particular item in a large worksheet, e.g. an employee name or a product.

Filters also enable you to select only the data you need, and to hide the data not relevant to your search. e.g. the students with the highest grade, or the records for a specific department.

Unlike sorting, filtering does not rearrange your data. It simply hides the rows you don’t want. You can then edit, format, chart and print your filtered data as you wish.

Preparing to filter

As with subtotalling, the data in your worksheet needs to be organised before filtering:

- Use headings
- Don’t mix the data types
- Don’t have blank rows or columns. Individual blank cells are ok.
- Ideally keep data to be filtered in a separate worksheet

We are going to look at filtering text and filtering numbers, first filtering text.
Filtering Text

The AutoFilter feature in Excel provides a quick way to create a filter, and can be used for text. To use AutoFilter, click in a cell containing a text data item. Then go to the Data tab and select Filter.

Task 6.1 Filtering Text

1. Open the file Filtering
2. Click in a cell containing text, go to the Data tab and select Filter.
3. Click on the down arrow next to the Department column heading to begin filtering. Excel displays a list of options as well as all the items in the column.
4. Deselect Select All, then tick the box next to Accounts and click ok.

All rows apart from Accounts are hidden. Notice that the down arrow to the right of Accounts has changed to a small filter symbol.
5. To add to the selection click on the small filter symbol next to Department, tick the box next to Customer support (retain the tick next to Accounts) and click ok.

Where you have applied a filter, the row numbers appear in blue and the drop down arrow changes to a filter symbol. In addition, the status bar at the bottom of the screen displays the number of records found.

Note: If you have a blank row or column in your worksheet AutoFilter will not process the data beyond it.

Filtering options and custom filters

The text filtering menu also allows you to set more than one condition and provides a range of filtering options: Equals, Begins With, Contains etc.

You can customise the filter, combining various options, and filter using various criteria, as shown in the screen shot.

In addition you can add multiple filter criteria and use:
- the And function where the results returned meet both criteria, or
- the Or function where the results returned meet either criteria.

To create a more powerful filter use wildcards. The wildcard character * can be used as a substitute for a series of any characters.

For example, when looking for the word millennium the wild character can be used to type mil*en*ium in the search box. This will ensure all instances of the word are returned allowing for various misspellings that can occur.
Task 6.2 Filtering Text

1. Continue using the file Filtering. Click on the filter button to the right of the column heading Department and remove the ticks next to Accounts and Customer Support.

2. On the filter menu move the mouse to Text Filters and across to Equals.

3. In the box to the right of Equals type Admin* and click ok.

Notice that the filter has picked up the records both where Administration has been correctly and incorrectly typed.

Filtering Numbers

Many of the filtering options that apply to filtering text also apply to filtering numbers. There are also additional filtering options for numbers. These include searching for the ‘Top 10’ items. This option does more than its name suggests, it actually searches for between 1 and 500 items.

Task 6.3 Filtering Numbers

1. Using the file Filtering click on the Department filters and choose Select All. Click ok.

2. Move to the down arrow next to Earnings (£), go to Number Filters and select Top 10.

3. Change the number to the top 6 and click ok. Observe the results.

4. Return to the Number Filters and, using the down arrow, change Top to Bottom to see the 6 lowest earnings. Observe the results.

The ‘Top 10’ feature enables you to search for the top or bottom 1 to 500 items. You can also search for the top or bottom percent.

Task 6.4 Removing a filter

You can choose to turn off specific columns or turn AutoFilter off completely.

1. Click the autofilter symbol at the top of the Earnings column and select Clear Filter From Earnings from the menu.

2. Go the Data tab and click Filter to turn off AutoFilter completely.

3. Keep the file open for the next exercise.

Filtering Dates

Excel provides many options for filtering a column of dates. For example you can select all this or last year’s dates, or all dates that occurred in a particular month.

In addition you still have the option to custom filter dates. The example illustrates the use of the And function to filter a range of dates.
Task 6.5 Filtering Dates

1. Continue using the file Filtering. Ensure the cursor is within the data table. Go to the Data tab and click on Filter.

2. Click on the down arrow next to Date of Hire.

3. Go to Date filters, and choose Custom Filter (at the bottom of the list that appears).

4. Set up the custom filter to select dates after 09/04/2011 and before 08/12/2013 and click ok.

If you have time try out a couple of the other date filters.

5. Close the file without saving the changes.

7. Pivot Tables

Pivot tables enable you to summarise and analyse large amounts of data in lists. This is done by dragging and dropping headings to different row, column, or summary positions.

Using Pivot tables you can:

- perform a large number of calculations simultaneously and see data trends
- quickly update the data because Pivot tables are dynamic.

Pivot Table terminology

The four categories (called fields) of information in a Pivot Table are:

- Page: The page field allows you to filter the entire Pivot Table report to display data for a single item or all the items. e.g. all students, or a specific student.
- Row: The row field displays the items in the field as row labels.
- Column: The column field displays the items in the field as column labels.
- Data: Data fields contain the summarised data. They are usually numeric, but can also contain text.
Task 7.1 Create a Pivot Table

We are going to use an example containing student names, exam marks, semesters and subjects. Each column has a heading and there are no blank rows in the range or table.

1. Open the file Pivot Tables and place your cursor anywhere in the data (but not in the headings) and click on the Insert tab and on PivotTable in the Tables group. The Create PivotTable dialogue box appears.

Under Choose the data that you want to analyse, Excel automatically determines the range for the PivotTable report.

2. Under Choose where you want the PivotTable report to be placed, choose a new worksheet. Then click OK.

3. The area on the right is composed of a field section and an areas section. Drag the field student from the field section to rows in the areas section, and subject to columns.

4. Drag mark to $\sum$ values and semester to filters

The data is organised by student and subject, and was totalled when the mark field was dragged to the $\sum$ values area:

![PivotTable Field List]

Tips: To reorganise your report you can remove fields and add them to different areas in the PivotTable Field List box. This is ‘pivoting’ the data.

To bring back the field list (if it disappears) right click on the PivotTable and choose Show Field List

Task 7.2 Display data for specific items

Pivot tables provide filters on the column and row headings to enable you to display data for specific items e.g. semesters or individual student marks.

1. Click on the drop down arrow to the right of Semester (All) and select Semester 1 to see Semester 1’s marks for all the subjects.

2. Click on the filter button next to Semester and choose Select All to see all the semesters’ marks again.

3. Click on the down arrow next to Column Labels, untick Select All and tick the box next to History to see the marks for History.

4. Click on the filter button next to Column Labels and choose Select All to see all the marks again.

Note: You cannot change the data in a PivotTable directly. You must change the source data and then refresh the PivotTable. To do this click on the PivotTable and then the PivotTable Tools, Analyse tab, then click Refresh in the Data group.
Formatting the data

PivotTable data can be displayed in various ways. By default PivotTables summarise total data. However the data can also be summarised in various ways, including:

- to count records in a list
- to calculate the average or
- to find the maximum or minimum value

Task 7.3 Calculate the average mark for each subject

1. Ensure that the cursor is within a cell containing a number in the PivotTable, and the context sensitive PivotTable Tools, Analyse tab is activated. Click on Field Settings from the Active Field group.
2. Choose Average as the type of calculation that you want use and click ok.

Notice that the PivotTable now displays the average mark for each subject.

3. Highlight the numeric cells in the Pivot Table and format the data to 2 decimal places. (Home tab, format, format cells, number).
4. Click the down arrow to the right of Semester (All) and select Semester 1 to see Semester 1’s average marks.
5. Save the changes and close the file.

Grouping data

A useful feature of PivotTables is the ability to group data. You can move the fields into position in the lower half of the PivotTable Field list to arrange rows into groups and sub-groups.

Task 7.4 Grouping data in PivotTables

In this example we shall group the PivotTable data by moving semester from the filters box to the rows box.

1. Open the file PivotTable Groupings
2. In the boxes below the field list drag Semesters from the filters box to just below Student in the rows box.
3. Observe the PivotTable. You can now see the student marks for both semesters.
4. Click on the box to the left of any student name to hide the sub-group data. Click to show the detail again.

⚠️ Note: Formulas for calculated fields operate on the underlying data. When updating data you must always update the underlying data table, not the data in the Pivot Table.
PivotTable Slicers

Slicers are graphic objects containing a set of buttons that enable you to quickly filter the data in a PivotTable report. They provide another way of filtering in PivotTables without the need to open drop-down lists.

Slicers clearly label the filter that is applied and provide details so that you can understand the data displayed in the filtered PivotTable report.

Task 7.5 Creating Slicers

1. Using the file PivotTable Groupings ensure your cursor is within the PivotTable, go to the Insert tab and click Slicer (in the Filter group)
2. From the Insert Slicers dialog box that appears tick School and click ok
3. To view filtered results using the slicer, click on each school in turn (ACE, HCA, LLC and SCI) in the slicer dialog box. Notice how the filtered results in the PivotTable change according to the school chosen.
4. Remove the filter by clicking the remove filter symbol.
5. Save and close the file.

Tip: To make sections of your PivotTable report more prominent, you can click in the table and use the PivotTable Tools, Design tab on the ribbon to format the design.

Course Conclusion

We hope that you found this course useful.

Tip: You can take what you’ve learned today and think about how to apply it to your work or studies. Reflect on the key things that you’ve learned in this course and how you can use them in future.

Help after the course:

For help after the course contact the Helpline at: is.helpline@ed.ac.uk

Downloading the course files:

You can download the course files from:

https://www.edweb.ed.ac.uk/information-services/help-consultancy/is-skills/catalogue/data-literacy/excel-intermediate

Lynda.com playlist:

https://www.lynda.com/MyPlaylists?playlistId=16554090